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Version 1.02 of Innova can export results for antibody identification tests to Resolvigen 3, moreover:
• It will export group identification results to Resolvigen 3.
• It will export patient's antigenic profiles for Rh and Kell.
• It will export results obtained with antibody screening panels when exporting results for antibody

identification panels.
AutoVue Innova 1.02 also differs from previous in the way it manages archived images.
In order to interface with Innova 1.02 you must use Resolvigen 3 version 1.20rc4 or above.

When interfacing with AutoVue Innova 1.02, make sure that you are using Resolvigen 3 1.20rc4 (or
above) and select AutoVue as instrument type within Resolvigen 3.

Also note that from version 1.20rc4 onward, Resolvigen 3 no longer requires abilitation codes for
interfacing to instruments.

Quick start
If you do not have time to go through this document, please read at least this paragraph.
In order to setup an instrument select  Configure in Tools menu, and click on Instruments tab.
Then select AutoVue from  Available Instruments Types (not AutoVuePre or AutoVue1.01) and
click the  Add button. Click  Edit Settings button to configure the AutoVue interface module. The
configuration reported below is reasonable:

If you want BioVue images to remain available for Resolvigen 3 even after they are deleted from
Innova, you should create a directory and enter its path in Image copy path; the  Image path and
Image path replacement fields should be left blank in 99.9% of the cases, so leave them blank
unless you wish to go into the details of this document.

Innova directory structure
Innova exports  test  data  for use by Resolvigen 3 into XML files named IdentXXXX.xml  (where
XXXX represent four digits from 0000 to 9999). After acquisition Innova saves images in JPEG
(Joint Photographic Exper Group) format files with names like 22101264_001.JPG (where the initial
part contains part of the barcode of the BioVue cassette).
Two directories are relevant when interfacing Resolvigen 3 to Innova:
• The directory in which Innova stores IdentXXXX.xml files; this is usually

 C:\OCD\AV2G\RESOLVIGEN.
• The directory in which BioVue JPEG images are stored; this is usually
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 C:\OCD\AV2G\RESOLVIGEN\IMAGES.

Resolvigen 3 defines a third directory which it uses to store copies of the BioVue images; if this
directory  is  defined,  Resolvigen 3  copies  images  here  when  importing  data  so  that  they  are
permanently stored even in case Innova software deletes images or the software directory structure is
changed.

Resolvigen 3 setup
In order to setup an instrument select  Configure in Tools menu, and click on Instruments tab.
Then select AutoVue from  Available Instruments Types (not AutoVuePre or AutoVue1.01) and
click the Add button.

A  new  instrument  will  be  added  to  the  Installed  Instruments list  and  default  values  will  be
displayed for it in the Property/Value table at the bottom of the window.

Click  Edit Settings button to configure the AutoVue interface module. The configuration window
contains four tabs; the first tab, Files, shows information related to the directory structure.
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You would usually leave  Image path and  Image path replacement empty; these fields are used
when Innova and Resolvigen 3 run on different machines and data is shared by mapping a directory.
For example, if images are stored on Innova PC in C:\OCD\AV2G\RESOLVIGEN\IMAGES and the
directory C:\OCD\AV2G\RESOLVIGEN is mapped to Z: on Resolvigen 3 PC, you would set Image
path to  C:\OCD\AV2G\RESOLVIGEN\IMAGES and Image path replacement to Z:\IMAGES.
Image copy path may be left undefined: in this case images will not be copied and Resolvigen 3 will
search the original path when requested to display a BioVue image.

The next  three  tabs  contain  information  that  is  needed by Resolvigen 3  to  translate  information
transferred from Innova.
The Panels tab lists the correspondences between barcodes used by Innova to identify Panels, and
actual Panel codes (e.g. RA123) used by Resolvigen 3.

The Panel codes tab lists the correspondences between names used by Innova to identify different
types of panels with the types used by Resolvigen 3.

The  Programs tab  matches  different  Programs  used  by Innova to  the  different  reaction  phases
(temperature, enzymes, etc.) used by Resolvigen 3.
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You do not need to fill any of these information right now: Resolvigen 3 will query for different
pieces of information when transferring data from Innova and will remember them for the next time.

Innova setup
In order to export results to Resolvigen 3, exporting to LIS must be enabled.
In SETUP mode select Data button on the right corner and click on Transfer to LIS field to open
the transfer configuration window (transfer setup).

In this page you should make sure that the Transfer to Resolvigen option is checked; the Protocol,
Format, Character set and End of line options should be configured as needed for transferring to
LIS but are of no concern for Resolvigen 3.

Exporting from Innova
You should at this point perform screening and identification tests as required; please note that data
is only transferred to Resolvigen 3 when an identification test has been performed for a given
patient.
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Usually you would perform some preliminary tests for a patient; for example ABO, Rh, Kell and say
a SurgiScreen. If you try to transfer at this point nothing is sent: Resolvigen 3 should be involved in
the antibody identification (not screening) task, so there is no reason to transfer results for screening
tests alone.
If SurgiScreen is positive you would probably perform a Panel A test. When you ask to transfer Panel
A/B/C results to Resolvigen 3, Innova will search results for the same patient for ABO, etc. for tests
performed in the last 24 hours and transfer them as well. Please note Innova will be able to locate
tests for the same patient only if the PID is used to identify the patient.

In Routine mode click on the Sample button at the top of the screen, then Results button on the left
and select Work list.
Click on the Transfer icon on the right of the screen, then select in the popup dialog which tests you
wish to transfer (e.g. All accepted results).

At this point results should have been exported. You may now import results into Resolvigen 3 as
described below.

For troubleshooting, you may check that a file named IdentXXXX.xml (where XXXX is a numeric
sequence from 0000 to 9999) was created in the directory C:\OCD\AV2G\RESOLVIGEN; you may
check the content of this file using Microsoft Explorer.
The file should look like the following example:

<?xml version="1.0" ?> 
  <doc>
  <Patient PID="1110071" FirstName="PRN71" FamilyName="NOM71" BirthDate="19891006000000">
    <Analysis AnalysisName="ABO" AnalysisResult="B" /> 
    <Analysis AnalysisName="Rh" AnalysisResult="POS" /> 
    <Analysis AnalysisName="Pheno" AnalysisResult="ccEe" /> 
    <Analysis AnalysisName="Kell" AnalysisResult="POS" /> 
    <Analysis AnalysisName="IgG" AnalysisResult="POS" /> 
    <Analysis AnalysisName="Poly" AnalysisResult="POS" /> 
    <Sample SampleID="712" SampleType="PLASMA">
      <Test Program="ABScr 3 Poly" PanelClass="Surgiscreen" PanelLot="1234">
        <Result Hole="1" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124956_001.JPG" URClassID="21"    
          URClassName="Surg 1" URValue="0" /> 
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        <Result Hole="2" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124956_001.JPG" URClassID="22"      
          URClassName="Surg 2" URValue="40" /> 
        <Result Hole="3" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124956_001.JPG" URClassID="23"     
          URClassName="Surg 3" URValue="40" /> 
      </Test>
      <Test Program="Panel A Poly" PanelClass="Resolve panel A" PanelLot="1234">
        <Result Hole="1" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124957_001.JPG" URClassID="46" 
          URClassName="Cell-1" URValue="0" /> 
        <Result Hole="2" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124957_001.JPG" URClassID="47" 
          URClassName="Cell-2" URValue="40" /> 
        <Result Hole="3" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124957_001.JPG" URClassID="48" 
          URClassName="Cell-3" URValue="40" /> 
        <Result Hole="4" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124957_001.JPG" URClassID="49" 
          URClassName="Cell-4" URValue="40" /> 
        <Result Hole="5" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124957_001.JPG" URClassID="50" 
          URClassName="Cell-5" URValue="40" /> 
        <Result Hole="6" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124957_001.JPG" URClassID="51" 
          URClassName="Cell-6" URValue="0" /> 
        <Result Hole="1" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124958_001.JPG" URClassID="52" 
          URClassName="Cell-7" URValue="0" /> 
        <Result Hole="2" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124958_001.JPG" URClassID="53"   
          URClassName="Cell-8" URValue="40" /> 
        <Result Hole="3" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124958_001.JPG" URClassID="54"  
          URClassName="Cell-9" URValue="40" /> 
        <Result Hole="4" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124958_001.JPG" URClassID="55" 
          URClassName="Cell-10" URValue="40" /> 
        <Result Hole="5" ImageName="C:\OCD\AV2G\RESOLVIGEN\IMAGES\22124958_001.JPG" URClassID="56"   
          URClassName="Cell-11" URValue="40" /> 
      </Test>
    </Sample>
  </Patient>
</doc>

The  only  part  worth  examining  are  the  names  of  the  exported  image  files,  for  example
C:\OCD\AV2G\RESOLVIGEN\IMAGE\22124958_001.JPG;  in case the images are not displayed
inside Resolvigen 3, you may wish to check that these files really exist.

You may later check which results have been transferred: In Routine mode click on the Data button
at the top of the Screen (or on the LIS Connection on the left) then select LIS Communication Log.
You may double click on any row of the file list to view details of the exported file and eventually to
retransmit it.



Interfacing AutoVue Innova 1.02 7/11

Importing data
Select the AutoVue instrument from the Instuments item of the File menu.

Assuming this is the first time you import from Innova, Resolvigen 3 will ask for some information;
increasingly less information will be asked for in the future when data is imported, as Resolvigen 3
remembers  data entered by the user.
First Resolvigen 3 asks for the phase in which reactions measured with the program used by Innova
should be recorded.

You will have to choose among the seven phases used by Resolvigen 3:
• Room temperature
• Room temperature with enzymes
• 37 ºC
• 37 ºC with enzymes
• Coombs polyspecific (anti-IgG+C3d)
• Coombs polyspecific (anti-IgG+C3d) with enzymes
• Coombs monospecific (anti-IgG only)

Next Resolvigen 3 will ask you for the panel type.

Resolvigen 3 needs to be informed that the panel type 'Resolve panel A' used by Innova is actually a
'Panel A'. It may seem obvious that 'Resolve panel A' matches 'Panel A', but Resolvigen 3 prefers to
ask, just in case: better safe than sorry.
Finally Resolvigen 3 asks for the Panel corresponding to the barcode received from the Innova.
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You should select a panel; if the needed panel is not available, you may decide to import it now by
clicking the Import new Panels button.

At this  point the test  should be imported correctly and you should be able to see it  in the main
window when the Tests group is selected.

Recently imported tests may be viewed by clicking the BioVue button in the toolbar.

Select an item and click the OK button to view it. Please note that the test has been imported, but the
corresponding patient has not been created, so Resolvigen 3 will ask you if a new patient should be
created now unless a patient matching data for the test is already recorded in patients' archive.

Click OK to create the patient or Cancel to skip to viewing test data without creating a new patient.
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You may now view the panel; by right-clicking on any of the scores you may view the image of the
matching BioVue well.

Maintaining conversion tables
Each time Resolvigen 3 asks for a piece of information, like the phase in which reactions obtained
with a specific Innova program should be stored, it keeps track of such information. It is possible to
browse and edit stored information, for example for correcting mistakes.
Select Configure in Tools menu, click on the Instruments tab. Select the AutoVue instrument in the
Installed Instruments list and click the Edit settings button.

The  Panels tab lists the associations between barcodes and panel codes for all the recently used
panels; if  Automatically remove expired Panels is checked, expired panels (that cannot be used
with Innova anymore) are automatically removed from this list; please note that these panels are not
removed from Resolvigen 3 archives.

If you wish to remove one item from this list, just select it and click the Delete Panel button.
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You may edit an item by selecting it and clicking the Edit Panel button. Click the Add Panel button
to add a new item.

The Panel codes tab lists associations between the names used by Innova to identify panel types and
the names used by Resolvigen 3.

If you wish to remove one item from this list, just select it and click the Delete panel type button.
You may edit an item by selecting it and clicking the Edit panel type button. Click the Add panel
type button to add a new item.

The Programs tab list the associations between the names of the programs used by Innova and the
phases in which Resolvigen records scores.

If you wish to remove one item from this list, just select it and click the Remove program button.
You may edit an item by selecting it and clicking the Edit program button. Click the Add program
button to add a new item.
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Troubleshooting tips
Are you using Resolvigen 3 1.20rc4 or later and Innova 1.02?
Are you trying to export screening tests alone?  Innova only exports data to Resolvigen 3 when
Identification tests for a given patient are present; at this point it will also export any other test
(screening, ABO, Rh, Kell...) recently performed for the same patient.
Have you enabled exporting to LIS? The selected format is not important,  but Innova will only
export to Resolvigen 3 if the Exporting to LIS option is enabled.
Have you enabled Transfer to RESOLVIGEN in Innova configuration?
Can you see IDENTxxx.XML files in C:\OCD\AV2G\RESOLVIGEN after exporting from Innova?
If not there is a configuration problem inside Innova software.
Are they deleted after importing to Resolvigen 3? if  not there is a configuration problem inside
Resolvigen 3 software.
Is AutoVue interface inside Resolvigen configured to import from C:\OCD\AV2G\RESOLVIGEN?
If you do not see BioVue images inside Resolvigen 3, are Image path,  Image path replacement
and Image copy path empty inside Resolvigen 3 configuration for AutoVue interface? This is the
simplest configuration that works when both AutoVue Innova software and Resolvigen 3 are run on
the same machine.

If results end up in the wrong phase, check configuration data in the  Programs tab ('Maintaining
Conversion tables' paragraph).
If results are exported with a wrong panel type or a wrong panel lot, check configuration data in the
Panels and  Panel codes tabs ('Maintaining Conversion tables' paragraph).


